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USER GUIDE

SCC-FT01 Feedthrough Module

The SCC-FTO1 is a feedthrough module that connects directly to the
analog input (AI) and analog output (AO) channels of a data acquisition
(DAQ) device. You can use the breadboard area of the SCC-FTO1 to
develop custom signal-conditioning circuitry that can connect to and
condition any of the analog, digital (P0.), and general-purpose
counter/timer (CTR) channels of E Series DAQ devices.

Conventions

The following conventions are used in this guide:

<> Angle brackets that contain numbers separated by an ellipsis represent
arange of values associated with a bit or signal name—for example,
Al <0..7>.

» The » symbol leads you through nested menu items and dialog box options

to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

> &

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on
the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

é When symbol is marked on a product it denotes a warning advising you to
take precautions to avoid electrical shock.

ﬁ When symbol is marked on a product it denotes a component that may be
hot. Touching this component may result in bodily injury.

bold Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.
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italic

monospace

SC-2345

SCC

Italic text denotes variables, emphasis, a cross reference, a hardware label,
or an introduction to a key concept. This font also denotes text that is a
placeholder for a word or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

SC-2345 refers to both the SC-2345 connector block and the SC-2345 with
configurable connectors.

SCC refers to any SCC series signal conditioning module.

What You Need to Get Started

To set up and use the SCC-FTO01, you need the following items:

U SC-2345/2350 with one of the following:
— SCC-PWRO1
—  SCC-PWRO02 and the PSO1 power supply
—  SCC-PWRO03 (requires a 7 to 42 VDC power supply, not included)

One or more SCC-FT01 modules

SCC-FT01 Feedthrough Module User Guide
SC-2345/2350 User Manual, available at ni . com

SCC Quick Start Guide, available at ni . com

Read Me First: Safety and Radio-Frequency Interference

SC-2345 Quick Reference Label

(I U N N N N W

68-pin E Series DAQ device, documentation, and 68-pin cable of
1 or 2 m length

(.

1/8 in. flathead screwdriver

(]

Numbers 1 and 2 Phillips screwdrivers

SCC-FT01 Feedthrough Module User Guide 2 ni.com



(]  Wire insulation strippers
[ NI-DAQ (current version) for Windows 2000/NT/XP/Me

If you do not have the current version of NI-DAQ or one of the
documents, you can download them from ni . com, or contact an
NI sales representative.

@ Note Software scaling of measurements is not supported on the Macintosh operating
system.

Device Specific Information

@ Note For general SCC module installation and signal connection information, and
information about the SC-2350 carrier, refer to the SCC Quick Start Guide, available
for download at ni .com/manuals.

Installing the Module

A Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting/disconnecting any signal wires.

A Caution If you plug the unmodified SCC-FTO01 into any SCC socket other than
single-stage Al (sockets J1 through J8) or AO (sockets J17 and J18), you can damage
the E Series DAQ device.

You can plug the SCC-FTO01, as shipped, into an Al or AO socket on the
SC-2345. When used as a prototyping module, the SCC-FTO01 plugs into
any socket on the SC-2345 except the power socket.

Five 0 Q resistors on the printed circuit board (PCB) connect a set of default
signals listed on the module label. To modify the SCC-FTO1 to perform
custom signal conditioning, refer to the Customizing the SCC-FT01
section.

Connecting the Input Signals

@ Note The signal names have changed. Refer to ni.com/info and enter rdtntg to
confirm the signal names.

The screw terminals are labeled by pin number <1..6>. The module label
lists the signal names beside the pin numbers. Pins 2 through 6 accept the
following signals: CH+, CH—, Al GND, AI SENSE, and EXT REF. Pin 1
does not connect to anything. Connect the wires accordingly.

© National Instruments Corporation 3 SCC-FT01 Feedthrough Module User Guide



Table 1 shows the signals available if you plug the SCC-FTO1 into
Al single-stage SCC sockets J1-J8 or AO SCC sockets J17 and J18.

Table 1. SCC-FT01 Signals

Screw Al Single-Stage

Terminal Screw SCC Socket AO SCC AO SCC

Number Terminal Label J1-J8 Socket J17 Socket J18
6 CH+ Al AO0 AO 1

CH- AT +8 AO GND AO GND

4 AIGND AIGND PFI 5 PFI 5
3 AI SENSE AI SENSE AO 1 AOO
2 EXT REF — EXT REF EXT REF
1 NO CONNECT — — —

When you plug the SCC-FTO1 into a single-stage AI SCC socket, the
following conditions are true for the labeled screw terminals:

¢ CH+ connects to the lower Al channel number CH(X), where
XisOto7.

e CH- connects to the higher Al channel number CH(X+8), where
Xis0to7.

e AI GND connects to Al ground.
e AI SENSE connects to Al SENSE.

¢ EXT REF does not connect—do not use it.

@ Note For information on Al modes, refer to the SC-2345 User Manual. For information
on Al configuration modes, refer to the DAQ device documentation.

When you plug the SCC-FTO1 into an AO SCC socket, the following
conditions are true for the labeled screw terminals:

¢ CH+ connects to AO 0 for AO SCC socket J17, AO1 for
AO SCC socket J18.

¢ CH- connects to AO ground.
*  AI GND connects to PFI 5.

e AI SENSE connects to AO 1 for AO SCC socket J17, AO 0 for
AO SCC socket J18.

e EXT REF connects to EXT REFE.

SCC-FT01 Feedthrough Module User Guide 4 ni.com




When you configure the SC-2345 as an accessory to the E Series DAQ
device in Measurement & Automation Explorer (MAX), the program
automatically configures the SC-2345 in nonreferenced single-ended
(NRSE) mode. Connect the signal source to single-ended channels on the
SCC-FTO01 while the SC-2345 is configured in the NRSE Al configuration.

You can configure the E Series DAQ device to read signals from the
SCC-FTO1 in differential mode. Use a virtual channel in MAX or
application software to configure the E Series DAQ device to read the
signal in differential mode. When you read a signal in differential mode,
you use two channels for one measurement, but you avoid ground loops and
get a better signal by rejecting common-mode signal noise.

You can configure the E Series DAQ device on a per channel basis with
application software or virtual channels. For example, you can have
channels 0 and 8 in differential mode and 1 to 7 and 9 to 15 in NRSE mode.
Refer to the Measurement & Automation Explorer Help for more
information and instructions on configuring channels.

For more information about configuring the SCC-FTO01 using NI-DAQmx,
refer to the SCC Quick Start Guide.

Customizing the SCC-FT01

You can customize the SCC-FTO01 to connect to any of the Al, AO, digital
input/output, or counter signals of the E Series DAQ device. After you
customize the SCC-FTO01, you can plug it into any SCC socket on

the SC-2345 except the SCC power socket. The SCC-FT01 PCB

contains 2.54 sq cm (1 sq in.) of prototyping breadboard area. This area
accommodates as many as four 8-pin integrated circuits and other discrete
components such as resistors and capacitors.

Place the SCC-FTO1 prototyping module label, which is included in the kit,
over the SCC-FT01 feedthrough module label on the SCC enclosure. This
label does not contain signal names, so you can customize the assignment
of the screw terminals.

Circuit Design

You must disassemble the SCC-FTO01 to install custom circuitry.
Complete the following steps to open the module.

1. Remove the screw from the back (wide unlabeled side).
2. Turn the front (wide labeled side) toward you.

3. Place the screw terminal receptacle on the left.
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4. Slide the top cover to the right.
5. Lift off the cover.

You must remove resistors R1 through R5, shown in Figure 1, before you
develop custom circuitry. The signal connection pads above connector J2,
represented by item 1 in Figure 1, connect to different signals on the

E Series DAQ device, depending on where you install the SCC-FTO1 on the

SC-2345.
! 0000 0000
Ofok[-qico 00 g% 0000
Olo 0000000000
0000000000
Qojeglocooocoo00000
Olo 0000000000
410000000000
Oloag coo0000000
[lo 0000000000
1Y/ ooooooo0000 ] |
1 /O Pads 3 Signal Connection Pads
2 Prototyping Breadboard Area 4 R1 through R5

Figure 1. SCC-FT01 Parts Locator Diagram

Table 2 shows the signals available for circuit design when you plug the
SCC-FTO1 into each type of SCC socket on the SC-2345. The pad numbers
correspond to the number next to each pad on the SCC-FTO1.

Table 2. Signals Available by SCC Socket Type

Signal Name
Pad
Number AI/PO. All AO CTR CHO CTR CH1
1 Al SENSE -15V EXT REF PFI 8/ PFI1 3/
CT RO SOURCE CTR 1 SOURCE
2 Al + REF5V J17—AO 1 PFI 6/ EXTSTROBE*
AO START TRIG or
118—A00 or AI — Cascaded
Al — Cascaded REF!
REF!
SCC-FT01 Feedthrough Module User Guide 6 ni.com




Table 2. Signals Available by SCC Socket Type (Continued)

Signal Name

Pad
Number AI/PO. All AO CTR CHO CTR CH1
3 AI GND GND (+5V) | AO GND(B) N/A PFI 1/AI REF
or TRIG
Al + Cascaded or
REF! Al + Cascaded
REF!
4 PFI 7/ +15V AO GND(A) FREQ OUT FREQ OUT
AI SAMPLE C
LK or
P0.(X)?
5 Al— GND (15 V J17—AO 0 PFI 5/ AI HOLD COMP
and REF 5 V) AO SAMP
JI8—AO 1 CLOCK
6 Al + Cascaded® | +5V PFI 6/ P0.6 PO.7
AO START TRIG
7 Al - Cascaded? _ PFI 5/ PFI 0/ PFI 0/
AO SAMP CLOCK | AI START TRIG AI START TRIG
8 AI SENSE _ _ _ PFI 7/
Cascaded? AI SAMP CLK
9 _ _ _ PFI 9/ PFI 4/
CTR 0 GATE CTR 1 GATE
10 _ _ _ CTR 0 OUT CTR 1 OUT

I Not a counter signal name. Available on any AI SCC socket J1 to J8.
2 Available on digital SCC sockets (J9 to J16) only.
3 Available on final-stage AI SCC sockets (J1 to J§) only.

5

Note AO GND (A) and AO GND (B) are both in the table, but both connect to the one
AO GND signal on the E Series DAQ device.

An SCC-FTO0L1 signal connection label, which defines the pad numbers
on the SCC-FTO01 board, is attached to the inside of the enclosure of the

SCC module.

Whether you plug the SCC-FTO1 into an SCC socket for Al, AO, digital,

or counter conditioning, the pads listed under the A/l column in Table 2 are

connected, and you can use them.

© National Instruments Corporation
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Wiring the SCC-FTO01

The signal names in the following sections refer to the signals listed in
Table 2.

@ Note When you plug the SCC-FTOL1 into the first-stage Al sockets on the SC-2345, you
do not connect the outputs of the circuitry to the pads labeled Cascaded. Use pads labeled
Cascaded only when you plug the SCC-FTO1 into the second-stage (final-stage) socket to
get the input signals through the SC-2345 from the first-stage socket. Refer to Figures 2a

and 2b.
SCC-FTO01 Prototype SCC-FTO1 Prototype
[ [
3| o S| o8 A
%) 5 Al GND %) 5 2% —oAIGND
4 4 £5
Ol 1, O |5 &
Ol 15 Ol 15 Al + Cascaded REF
© 1 N 4 b————o0Al + Cascaded
[ [
a. First-Stage Analog Input Mode b. Second-Stage Analog Input Mode
SCC-FTO1 Prototype
[
g 5 Al +
%) 5 0 o Al GND
e 4
S| B
L 2 Al -
_/ | 1
c. Single-Stage Analog Input Mode

Figure 2. SCC-FT01 Prototyping Module Al Configurations

Figures 2a and 2b illustrate example wiring for the SCC-FTO1 prototyping
module used in dual-stage Al configuration. Figure 2c¢ illustrates
single-stage Al configuration.

Analog Input and Digital Input/OQutput

To use the SCC-FTO1 for Al or digital signal conditioning, use the pads
above connector J2 labeled AI/PO. for connections to the breadboard area.
You then can plug the module into any AI SCC socket J1 to J16 on the
SC-2345. The signals available are slightly different when the module is
plugged into the first-stage Al (also known as digital) than when plugged
into the second-stage Al (also known as single-stage Al). Use SCC sockets
J9 to J16 for first-stage Al. Use SCC sockets J1 to J8 for second-stage Al

SCC-FT01 Feedthrough Module User Guide 8 ni.com



PFI 7/A1 SAMP CLK, AI + Cascaded, Al + Cascaded REF,

Al — Cascaded, Al — Cascaded REF, and AI SENSE Cascaded signals are
available for the second-stage AI SCC sockets only. The P0.(X) signal is
available for the first-stage AI SCC sockets only. Refer to Table 2 for pad
definitions.

When the E Series DAQ device is configured in NRSE Al mode, design
your prototype circuitry so that the output of the SCC-FTO1 to the E Series
DAQ device is referenced single-ended to Al GND on the SC-2345.

@ Note On the SC-2345, the Al GND and AI SENSE signals join at connector J24.

Analog Output

To use the SCC-FT01 for AO signal conditioning, use the pads above
connector J2 labeled AO for connections to the breadboard area. The
AO column in Table 2 lists the signals available to each pad. Plug the
SCC-FTOLI into any AO socket on the SC-2345.

The AO 0 and AO 1 signals depend on which AO SCC socket you use.

If you plug the SCC-FTO01 into the AO SCC socket J17, the DAC (A) pad
connects to AO 0 and the DAC (B) pad to AO 1 on the E Series DAQ
device. These pad connections are reversed when the SCC-FTO1 is plugged
into AO SCC socket J18, and the DAC (A) pad connects to AO 1 and
DAC (B) pad to AO 0 on the E Series DAQ device.

Counter

To use the SCC-FTO1 for CTR functions, use the pads above connector J2
labeled CTR for connections to the breadboard area. The CTR CHO and
CTR CH]I columns in Table 2 list the signals available to each pad. The
signals available depend on which SCC socket you use.

If you plug the SCC-FTO1 into the CTR CHO socket J19, the pads under
CTR CHO on the board connect to signals associated with CTR channel 0
and AO of the E Series DAQ device. When the SCC-FTO1 is plugged into
the CTR CHI1 socket J20, the pads under CTR CH1 on the board connect
to signals associated with CTR channel 1 and Al of the E Series DAQ
device.

© National Instruments Corporation 9 SCC-FT01 Feedthrough Module User Guide



Connecting the Screw Terminals

The pads next to connector J1 connect to each input of the screw terminal
connector. Use these pads to connect the external signals to the circuitry
you added in the breadboard area. The numbers next to each hole
correspond to the screw terminal numbers. Space is available on the
SCC-FTO1 prototyping module label for custom signal names.

For information about how to configure the SCC-FT01 module using
NI-DAQm, refer to the SCC Quick Start Guide.

Specifications

These ratings are typical at 25 °C unless otherwise stated.

Analog
Number of input channels....................... 1 DIFF or 2 SE (when plugged
into an Al socket on the SC-2345)

Number of output channels..................... 1 (when plugged into an
AO socket on the SC-2345)

Power Requirement

No power required (if unmodified)

Physical
Dimensions ..........coeevveeeeeeiiveeeeeeniirneeeenn. 8.89cm x2.92cmx 1.85cm

(3.50 in. x 1.15 in. X 0.73 in.)

I/O connectors..........coceecveveeceinienienennens 20-pin right-angle male connector
6-pin screw terminal system

Screw terminal.........ccoooovevvvieiiiiiiiieeeenns 28t0 16 AWG

Safety

This product is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:

 IEC61010-1, EN 61010-1
e UL3111-1,UL 61010B-1
» CAN/CSA C22.2 No. 1010.1

SCC-FT01 Feedthrough Module User Guide 10 ni.com



@ Note For UL and other safety certifications, refer to the product label, or visit
ni.com/hardref.nsf, search by model number or product line, and click the
appropriate link in the Certification column.

Electromagnetic Compatibility

EmiSSiONS....cccvvvveiiieiieiie e EN 55011 Class A at 10 m
FCC Part 15A above 1 GHz

Immunity .....ccccoeeeviniininiiie, EN 61326:1997/ + A2:2001,
Table 1

CE, C-Tick, and FCC Part 15 (Class A) Compliant

@ Note For full EMC compliance, operate this device with shielded cabling. In addition,
all covers and filler panels must be installed.

CE Compliance

This product meets the essential requirements of applicable European
Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety).............. 73/23/EEC

Electromagnetic Compatibility
Directive (EMC) ......cccoeviiviiiiniiiincenns 89/336/EEC

@ Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit
ni.com/hardref.nsf, search by model number or product line, and click the
appropriate link in the Certification column.

National Instruments™, NI™, ni.com™, and NI-DAQ™ are trademarks of National Instruments
Corporation. Product and company names mentioned herein are trademarks or trade names of their
respective companies. For patents covering National Instruments products, refer to the appropriate
location: Help»Patents in your software, the patents. txt file on your CD, orni . com/patents.
P y P xetfeony Locon/p 371075B-01 Mar04
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